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1. Introduction 

1.1. The Electronic Voice Phenomenon (EVP) 

"Electronic Voice Phenomena" (EVP) are recordings of utterances upon 
sound recording media (recorder tapes, cassettes, video tapes, etc.) 
which are physically unexplainable. These voices are often reasonable 
messages replying to corresponding questions, or they are referring to 
circumstances concerning the experimenter. The voices sometimes seem 
to show even precognitive or telepathically transmitted contents, i.e. the 
voices are referring to future events or to things concerning another 
person of which the experimenter has no knowledge at the time of the 
recording. 

This phenomenon has been discovered in 1959 by the swedish artist 
Friedrich Jürgenson, who made them public as "voices from the 
hereafter". In fact, these voices often call themselves the "dead" or the 
"deceased". Whether or not this is the only valid explanation remains to 
be seen... 
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To carry out such experiments, no high-tech equipment is required - 
standard equipment and a little bit of patience are sufficient to reproduce 
this fascinating phenomenon. In the simplest case, this can for example 
be done by putting a cassette recorder into "Recording" mode and 
capturing some background noise (= acoustic "raw material") via the 

microphone. From time to time you may ask a question. The voices can 
be heard afterwards during the playback of the tape. 

More information about this topic can be found on the Web site of VTF, 
the German Association For Transcommunication Research or AA-EVP, 
the American Association of Electronic Voice Phenomena. 

 
1.2. The "raw material" 

In order to record EVP it seems to be necessary to provide some kind of 
"raw material" which is used as a "carier" for the voices. Inside of 
soundproof rooms without any acoustic source, no voices seem to be 
formed at all. The frequency spectrum of this raw material - no matter if 

it's a direct sound event or if it's modulated onto various carriers (radio 
waves, light etc.) - apparently has to be within the audible range. One of 
the most common views is, that the voices result from 
paranormal transformations of the raw material. However, up to now this 
assumption could not yet be confirmed clearly in experiments. Usually 
the voices are already contained within the raw material. In my 
article Hypothesen zur Entstehung des Tonbandstimmen-
Phänomens (Hypotheses about the origin of the Electronic Voice 
Phenomenon) I have made some reflections on this topic. 

There are various methods existing to generate, transmit and record the 
raw material. Many experimenters use a radio set which is tuned to a 
foreign-language radio station, or to a mixture of several radio stations, 
as a raw material source. It is important that the experimenter does not 
understand the language of the raw material because this would be 
distracting. I personally don't prefer this method because it's too error-
prone since it can be very delusive if you are interpreting something as a 
message which in fact is a usual word in the foreign language. A raw 
material that is "unsuspicious" but is as similar as possible to language 

had to be found! 
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Already in 1988, when most people knew computers only from science 
fiction movies, the former president of the German Association For Tape 
Voice Research (VTF e.V.), Fidelio Köberle, had the following idea: 

"[...] to provide an artificially generated raw material, like for instance the often used noise from rippling water or Struck's 

"rubbing method". Ideal could be a continuously produced synthetic raw material which comes as close to speech as 

possible. As close as possible in order to allow the interlocutors on the other side to form real speech from it using as little 

energy as possible. Little energy, because we know that this works best (see transformations). The raw material must of 

course not already be speech but sould be transformed into reasonable speech easily. It should bubble without periodicity. 

It should, like usual speech, contain pauses. Without the use of random generators this won't be managed. [...]". [1] 

 
1.3. Random controlled speech synthesis 

Inspired by this suggestion, different means to generate such a raw 
material had been developed. Electronics engineer Peter Stein (Denmark) 
for example used two stereo cassette players (walkmen) and switched 
continuously between their four audio tracks by means of an electronic 
switch. The switching speed could be varied. However, for me personally 
this method wasn't flexible enough and the generated raw material 
wasn't "dynamic" enough. Inspired by the psychokinesis experiments of 

the parapsychologist Helmut Schmidt, I wanted to use a real random 
number generator (RNG) for the focus of potential paranormal influences. 
Each random number should be assigned to a certain phoneme of the 
German language. While the RNG was running, the corresponding 
phonemes should be played back via a speaker. With a little "practice" 
the originators of the voices should be able to synthesize their messages 
by influencing the RNG mentally. Since it probably would have been 
rather expensive to realize this by electronic means, I decided to make 
use of a computer. 

 
Audio-Ed 

In those days (1989), PCs were still expensive, and sound cards weren't 
available anyway. The Amiga already had fantastic sound capabilities, 

but at that time I owned the C64 home computer, so I gave it a try. It is 
true that the C64 had a sound chip which could produce sounds 
artificially, but you couldn't use it to synthesize speech. Then, by chance, 
I found in an electronics shop a kit for a so called "Audio Interface" which 
could be connected to the User Port of the C64 in order to digitize audio 
signals, store them into the computer memory and play them back later. 
The Audio Interface used "Delta Modulation", an 1-bit A/D and D/A 
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conversion. It was very unprecise, and sounded totally noisy, but 
occupied very little computer memory. Nevertheless the only 48 
kilobytes of memory were already full after 13 seconds of recording time. 
But this was sufficient for my purposes; after all it was possible to store 
about 100 phonemes (if you base on an average phoneme duration of 

0.1 to 0.2 seconds), and that was absolutely sufficient to synthesize 
artificial speech. 

To operate the Audio Interface, a little BASIC program was enclosed (of 
course as a listing for typing in) which POKEd some Assembler routines 
from DATA lines into the main memory. I used a "Machine Language 
Monitor" (something similar to DEBUG under MS-DOS) to disassemble 
the program and to add some further functions to edit, save and load the 
audio signal. I called the resulting program simply Audio-Ed. The 
part "Ed" indicates, that this program was able to edit an audio signal: 

You could cut out short sound sequences by ear and store them as 
individual segments onto "Floppy-Disk". If you had collected enough 
phonemes, you could make a phoneme file from them. These phonemes 
could be used to generate "random speech" which sounded like 
"gibberish". Additionally, there was a function to control the choice of the 
phonemes via the Game Port, so that an external random generator 
could be connected to the C64. 

But regarding the quantity and quality of the obtained EVP, it turned out 
in practice that it is irrelevant if "real" phonemes are used, or if simply 

small pieces (segments) of equal duration are cut out automatically from 
the audio signal. Also if "real" random numbers or only "pseudo" random 
numbers are used to select the phonemes/segments turned out to be 
insignificant. In this connection, here a little anecdote: 

Once during an EVP session using female speech as a raw material, I received the quite distinct and striking voice 

"Computer ist kaputt!" (German for: "Computer is kaput!"). I didn't know what to do with it, because apparently my 

device worked very well. On the next day I used the same raw material again for an EVP recording (I had stored the 

sample on a diskette). I was very surprised when I suddenly heard exactly the same voice "Computer ist kaputt" again! 

What has happened? 

Since the C64 had no built-in real time clock, the RNG had been initialized with the same starting values each time it was 

switched on - until then I hadn't been aware of this fact. But how could this be? Such a distinct voice from pseudo random 

numbers? Moreover, through this incidence the voice obtained a certain meaning by giving me to understand in a coded 

form (which is often the case with EVP) that the RNG did not work the way I assumed. Since the literature always 

mentioned a "random" number generator, I wrongly assumed that it would produce "real" random numbers. Therefore my 

hypothesis was that this RNG could be influenced paranormally. But obviously this did not happen, since otherwise this 

voice would not have been produced once more. 

http://www.stefanbion.de/evpmaker/computer.wav


The conclusions from this incident were far-reaching: Apparently it 
was not necessary for the generation of distinct and meaningful EVP to 
influence the devices in some paranormal way! (Meanwhile my theory is 
that the EVP phenomenon as well as other paranormal phenomena is 
based on some kind of "synchronicity".) 

In 1990, Audio-Ed had been rewritten for a PC (80286 CPU) under MS-
DOS and extended by a "logging" feature. With it, the generated 
sequence of random numbers could be logged into a logfile during the 
(pseudo) random controlled playback of the segments. Later exactly the 
same "raw material" could be played back again in order to "repeat" an 
EVP session. By this means it was possible to examine if the same voices 
were obtained again. (In my own experiments, this was always the case 
- thus no "transformations"!) 

 

Audigit 

Since editing each individual phoneme and compiling a complete 
phoneme set was always a very time consuming task, and because 
randomly cut segments work as well as phonemes, the next program 

version got no more editing function at all, thus it was given the 
name "Audigit". This version - now written in C - worked with 8-bit D/A 
and A/D conversion. Sound cards were still nearly unaffordable, therefore 
I used a self-made "Sound Digitizer" which I built from a construction 
manual which was printed in the October 1990 issue of the German 
computer magazine "DOS International" (now "PC Magazin"). Sound card 
support was added later. Since Audigit was a DOS program, the usable 
memory was still limited to 640 KB which allowed only a short recording 
time (about 25 seconds at a sample frequency of 20 kHz and a resolution 

of 8 bit). Moreover it only worked with 100% Soundblaster compatible 
sound cards. Therefore in May/June 2000 I wrote a "successor", the 
program EVPmaker, which runs under Windows 9x and Windows NT, 
works with any sound card and has no memory limitations. 

 
EVPmaker 

EVPmaker is far more than just a program for generating synthetic raw 
material. Of course it can be used for that purpose now as ever, and who 
intends to use it merely as an "raw material source" will have no 
problems to operate the program. But the actual innovation is the 



possibility to record whole "EVP Sessions". An EVP session can consist of 
any number of individual EVP. Each EVP is automatically provided with 
the current date and time. For each EVP a question and an interpretation 
can be entered. EVP sessions can be saved to disk and loaded again 
later. The raw material sequence of each EVP can be repeated as often 

as you wish, it can be saved as a WAV file, or it can be loaded into an 
sound editor where it can be processed or examined in any way. Every 
single raw material segment, from which the randomly generated 
sequence has been composed of, is stored in a "cue list". If the sound 
editor is able to display such a cue list, then these segments can be 
addressed and played back directly. In this way you can examine exactly, 
from which fragments a voice has been composed of. 

Another feature is the possibility to use "real" phonemes for the 
generation of the raw material for EVP recordings. With sound editors 

such as CoolEdit, the phonemes can be cut out from an audio signal and 
saved to disk together with their label (phonetic transcription). These 
phonemes are then read by EVPmaker. While the phonemes are being 
played back in random order, their labels (thus the phonetic transcription 
symbols of the phonemes) are being logged. Later these symbols are 
being displayed together with the corresponding EVP sequence. So if you 
hear an EVP, you can additionally read it in phonetic transcription. 

 

1.4. The functional principle of EVPmaker 

You can imagine yourself EVPmaker as a meat grinder - or better, as a 
"sound grinder": Like a meat grinder grinds meat, EVPmaker "grinds" 

sound. It takes a source audio file (WAV audio format), "chops" it into 
small segments, and then plays the chopped sound back via the speakers 
connected to the sound card of your PC. Like a meat grinder has different 
grinding plates to vary the fineness of the ground meat, EVPmaker allows 
you to vary the segment size between 0.001 seconds and 10 seconds. If 
you're lucky and listen carefully to this "ground sound", you'll hear 
hidden personal messages within this "gibberish"... 



 

Actually, there exist other programs called "sound granulators", like for 

instance GranuLab, which is used by musicians to produce interesting 
sound effects. Compared to this, EVPmaker is only a very simple sound 
granulator. But EVPmaker has some special features especially for EVP 
research. One of these features is the ability to log the sequence of the 
segments from the source WAV file, together with some other 
information (date, time, sequence number, question, heard answer), into 
an "EVP session" file. Additionally, the information in this session file can 
be used by EVPmaker to reproduce an previously generated EVP at any 

time, or to export an EVP to a new WAV file (output WAV file). An EVP 
session can contain several individual EVPs. 

As I mentioned, the EVP session feature is optional - you can use it, but 
you don't have to. If you don't use it, you must record the chopped 
sound by any other method - for instance by a usual cassette recorder, 
or by the computer itself (while playing back simultaneously). 

 
2. Technical and legal notes 

2.1. Download, Installation 

http://hem.passagen.se/rasmuse/Granny.htm


The current release of EVPmaker can be downloaded from the following 
WWW address: 

 http://www.StefanBion.de/evpmaker/evpminst.exe [size about 1.6 
MB] 

To start the installation, please double-click the .exe file after the 

download has succeeded. The queries of the installation dialog may be 
simply confirmed by clicking on the "Next" buttons. Of course, the default 
values for the "Installation path" and the "Start menu group" can be 
changed as needed. Finally a click on "Install" will start the installation... 

If you should want to uninstalled the program later, double-click the 
"EVPmaker" entry in the Windows standard software install/uninstall 
dialog ("Start > Settings > Control panel > Software"). 

Here is technical info for concerned users: No .dll or other files will be 
copied into the Windows system folder. Only the program and manual 

files will be copied into the application folder, and a Start menu group 
and a shortcut on the desktop will be created. Below the application 
folder an empty folder with the name "user" will be created which is 
intended to contain the source WAV files for the generation of the raw 
material, the session files, and the WAV files from exported EVP 
sequences. If you would like to use a different standard folder for this 
purpose, then you must enter this path as "Working directory" in the 
"Properties" dialog of the shortcut(s) to the program. Finally the file type 
EVP will be registered and associated to the program. 

 
2.2. Copyright 

EVPmaker has not been written in commercial interests, but for fun of 
programming and for scientific curiosity. Therefore, I don't want any 
money or other material returns for EVPmaker; thus the software is 
distributed as "Freeware". Nevertheless, I reserve all rights for this 
program, EVPmaker is Copyright © by Stefan Bion. 

The idea on which the program is based - the generation of raw material 
for EVP recordings by random controlled assembling and playback of 
individual segments of an audio signal - is common knowledge and as 
such not subject to copyright. 

http://www.stefanbion.de/evpmaker/evpminst.exe


 
2.3. Disclaimer 

EVPmaker is supplied on an as-is basis. The author offers no warranty of 
its fitness for any purpose whatsoever, and accepts no liability 
whatsoever for any loss or damage incurred by its use. EVPmaker is not 
a supported product. The author accepts no commitment or liability to 
address any problems that may be encountered in using it; 

however, EVPmaker is continually being developed and improved, so he 
is always interested to hear about any bugs or deficiencies. 

 
2.4. Distribution 

The program may be distributed or made accessible to the public in its 
complete and unchanged form, along with the manual. Concretely this 
means that only the unchanged installation file evpminst.exe may be 
passed on. 

 
2.5. Feedback 

Your feedback regarding bugs or results in your work with EVPmaker is 
greatly appreciated; my current e-mail addres can be found here. 

 
2.6. Updates, version history 

EVPmaker is continuously being developed; always the latest version is 
available for downloaded. Major changes and improvements are marked 

by an increased version number. For minor bugfixes or for "cosmetic" 
corrections only an internal version number will be increased, which is 
displayed under the "Version" tab in the "Properties" window (available 
through right-click on the program icon). 

Here now follows a survey of updates, sorted by the "major" version 
number: 

Version 1.0 (06/13/2000) 

 First release. 

Version 1.1 (06/22/2000) 

http://www.stefanbion.de/evpmaker/evpminst.exe
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 Added option "Z-Cross" (Zero Cross Adjust) to eliminate the "clicks" 
between the playback of segments 

 Display cue labels without blanks between them. 
 Font can be set for the display of the cue labels (by right-click). 

Version 1.2 (07/22/2000) 

 Bugfix: Editing of question and EVP interpretation didn't work - now 
it does. 

Version 1.3 (04/01/2001) 

 For the segment length you can now enter a "From" and a "To" 

value so that the actual segment length used by the program will 
vary randomly between a minimum and a maximum value. 

 The program now supports 'Drag & Drop', i.e. WAV and EVP files can 
be opened by dragging files from the Windows explorer into the 
program. 

 If you double-click on an EVP file, EVPmaker will be opened and the 
EVP session will be loaded. Besides EVP files also WAV files can be 
opened via the command line. 

 The position of the EVPmaker window will be saved on Exit and 

restored when the program is started the next time. This Option can 
be deactivated. 

Version 1.4 (04/08/2001) 

 The source for the generation of random numbers can now be 
chosen between pseudo random numbers (like previously), input of 
the sound card, and a file. 

 'Drag & Drop' now also works for PCM files as a random source. 
 Bugfix concerning the "Z-Cross" (Zero Cross Adjust) function. 

Version 1.5 (04/16/2001) 

 New random source added: Fractal formula (Logistic Equation). 
 Option "Best Sample Rate" added: You can choose now whether the 

sample rate of the loaded WAV file or 44100 Hz is used for the 
recording with "Random source = Soundcard". 

 Option "Use absolute values" added: Specifies whether for "Random 
source = Fractal formula, Soundcard or File" the absolute values are 
taken as random numbers, or if 32-bit numbers are computed from 
them. 
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 Two new functions to write and log the random numbers into a text 
file (for statistical analysis). 

Version 2.0 (05/20/2003) 

 An introducing Step-By-Step Guide with practical examples is now 
available via Help > Quickstart Guide in the menu. 

 New "Cross Fade" option to make the output sound "softer". 
 New option to use separate folders for each file type (source WAV 

files, output WAV files, EVP session files, random number source 
files, random number files). 

 EVPmaker can now add effects to the source WAV file such as echo 
or reversing. 

 "Visual Feedback" to possibly enhance the assumed 
communications. 

 Speed control (50...200%) for playback. 
 Recording function - you don't need another program anymore to 

record source WAV files. 
 Recorded/changed source WAV files can now be saved. 
 If there is more than one sound card inside the computer, you can 

select now which one is used for playback, for record, and 
as random number source. 

 No more limitation of the number of Cues in WAV files to 1000. 
 If the WAV file being part of the EVP session file cannot be found 

any more because e.g. it was moved or renamed, a dialog appears 
now to search for the file. 

 The smallest segment length is now 1 ms (instead of 10 ms). 
 The font of the cue labels will now be saved in the INI file. 
 The option "Z-Cross" (Zero Cross Adjust) is now available also if 

"Use Cue List" is activated. 
 ... and 5 further minor changes. 

Finally also 3 bug fixes: 

 Under certain conditions there was an error message saying "Access 
violation" if you answered "No" to the question if a changed session 
file should be saved. This bug also caused "endless saving" if a 
session was saved repeatedly. 

 An error message saying "Division by zero" appeared when a WAV 
file was tried to open which was no standard PCM file but an "ACM 
Waveform" file. 
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 If short segments (< 31 ms) were used, there was a small audible 
gap at the beginning of the random controlled playback and of the 
playback of EVP session files. 

Version 2.1 (07/05/2003) 

 New option "Normalize to achieve optimal recording level" for the 
automatical adjustment of the recording level. 

 New function "Normalize signal" in the "Effects" menu to adjust the 
level of a loaded source WAV file to an optimal value. 

 2 bugfixes in the recording function and 1 bugfix in the "Open WAV 
file" function. 

 
2.7. Known bugs and restrictions 

 Only Cue Lists will be considered. Other kinds of information in WAV 
files such as for instance the Play List will be ignored and are lost 

after saving the source WAV file! 
 For some WAV files that don't keep to the standard (e.g. a missing 

pad byte with an odd chunk size) it's possible that the Cue List will 
not be found. 

 If Windows is configured to use "Large Fonts" (120 instead of dpi), 
occasional display errors may occur in the program window (e.g. 
labels will be cut off). 

 
3. Program description 

3.1. Start 

After this survey I will now describe the functions of the program. But 
first of all, I'd like to invite newcomers to open the introducing Step-By-
Step Guide via Help > Quickstart Guide in the menu and to replicate 
the given practical examples. 

After EVPmaker has been installed, it can be started either by double-
clicking the "EVPmaker" icon on the desktop or by choosing "EVPmaker" 
from the Start menu. 

 

http://www.stefanbion.de/evpmaker/evpmkr_e.htm#recordwav
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After the start, the main window of the program appears: 

 

 

Overview 

First of all, here follows an overview of the individual areas of the 
program window: 

At the top there is the menu bar (File Session Extras Help). All 
functions of the program except of those in the 

menus Extras and Help can be reached by buttons as well as via the 
menu. In the menu, there are shortcuts displayed for most of the 
functions. These shortcuts usually consist of letters which must be 
pressed together with the Ctrl key in order to activate the corresponding 
functions. 

Below the menu bar there are the buttos  (Open),  (Save), 
 (Record),  (Play),  (Make EVP),  (Pause) and  (Stop). These 
buttons serve to load a source WAV file, save it, record sound, play it 
back, start the random controlled playback, pause and continue the 

playback, and to terminate the playback. How this works exactly will be 
explained in detail in section 3.2. ("Generating raw material"). 



Depending on which functions of the program are available at the 
moment and which aren't, the buttons as well as other elements will 
appear either activated (colored) or deactivated (grey). 

For the buttons there exist shortcuts as well, so that every function can 
be executed without using the mouse. For the upper buttons these are 

the function keys F2 to F8, and for the remaining buttons these are the 
underlined letter which has to be pressed simultaneously with the Alt 
key. The shortcut letters of the menu functions (Ctrl-...) correspond with 
the shortcut letters of the buttons (Alt-...). 

Below the buttons the two areas Segments and Play EVP are following. 
Under Segments, the length of the individual segments which are 
played back randomly can be entered. Furthermore you can select here, 
whetherEVPmaker itself shall determine the segments for the random 
controlled playback, or whether the sections defined in the Cue List shall 

be used instead (Use Cue List). The first option is very easy to use, 
because any WAV file is suitable. For the second option, first of all a cue 
list has to be created and stored into the WAV file using a sound editor. 
In the area Play EVP you can choose whether the random controlled 
playback shall happencontinuously until the  (Stop) button is clicked, 
or whether it shall stop automatically after a certain number of seconds. 

Below the two function groups Segments and Play EVP there is the 
area EVP Session which takes up the largest area of the program 
window. Here a new session can be started, sessions can be stored in 

session files, or previously recorded sessions can be loaded. For each 
EVP a question and the heard interpretation of this EVP can be entered. 
For each session, as many EVP as you like can be recorded. While 
skipping forward and backward between the individual EVP, the 
corresponding questions and interpretations are being displayed. If the 
cue list of the source WAV file has been used to generate the raw 
material for the EVP, additionally the cue labels (phonetic transcription) 
will be displayed in this area. Later in this manual an example will be 
given which shows how to work with "EVP sessions". 

At the bottom of the program window the status line is located which is 
subdivided into three parts. Here some parameters of the loaded source 
WAV file are being displayed: The sample frequency (e.g. 44100 Hz), the 
sample resolution (8 or 16 bit), channels (stereo or mono), number of 
cues, duration of the signal in seconds. 



 
3.2. Generating raw material 

This section will describe how EVPmaker is used to generate acoustic raw 
material for EVP recordings. If you just want to make some EVP 
recordings, this is all you have to know. First of all, a source WAV file has 
to be loaded (option 1) or recorded (option 2). If possible, it should be a 
recording of speech. For example, you could record something from the 

radio, or you could speak into the microphone. 

 
Option 1 

In order to record a WAV file, the radio must be connected to the "Line 

in" input resp. the microphone must be connected to the "Mic" input of 
the sound card via a cable. At the mixer (this is the program which is 
used to adjust the various inputs of the sound card; it can be accessed 
by double-clicking the little speaker symbol besides the windows clock on 
the lower right), the corresponding input ("Line In" or "Mic") must be 
activated, and the controls should be in middle position. Next, click on 
 (Record), and a window will open which lets you choose the suitable 
recording parameters: 

 

For the sample values, 11025 or 22050 Hz, 8 bit resolution and one 
channel (mono) should be sufficient for this purpose. If the 
option Normalize to achieve optimal recording level is activated, the 
level of the recorded signal will automatically be adjusted to the greatest 
amount of amplification that will not result in clipping. A click on 
the Start button will begin the recording immediately. While the 

recording is running, the time display in the status bar will be 
incremented. After you have recorded for some minutes or seconds, click 
on  (Stop) to end the recording. 



To save the recording for later use, click on  (Save), browse to the 
destination folder and enter a filename for the WAV file: 

 

Of course, saving the file isn't necessary for the generation of raw 
material; if you prefer to generate "fresh" basic material for each EVP 
recording, you don't need to save the recording. 

 

Option 2 

To open an existing WAV file, click on  (Open), and an "Open" dialog 
window will appear, which lets you select the file. 

 

Alternatively, a WAV file can also be opened simply by dragging the file 
with the mouse button pressed from the Windows Explorer into 
the EVPmaker window and drop it there ("Drag and Drop" method). By 



the way, the same works also for the EVP files which will be discussed 
later. 

The name of the loaded WAV file appears now in the title line of the 
program, and in the status line further information is given (sample 
frequency: 9395 Hz, resolution: 8 Bit, channels: mono, Cues: 0, Duration 

of the sample: 51.92 seconds). 

 

 
Playing the entire recording 

By clicking on the button  (Play) you can listen to the whole WAV file. 
The playback can be paused by clicking on  (Pause). By another click 
on  the playback is continued. The playback either runs until the end 
and will then be stopped automatically, or it can be stopped prematurely 
by clicking on the  (Stop) button. 

 

Random-controlled playback 

The random controlled playback can be started by clicking on the 
 (Make EVP) button. Here the buttons  (Pause) and  (Stop) are 
effective as well. While the random controlled playback is running, an 



EVP recording can be performed as usual. It turned out to be practical to 
send out the computer generated random speech signal into the room 
via speakers and to receive it by a microphone which is connected to a 
cassette recorder. The questions of the experimenter are being recorded 
along with the acoustic raw material. As a microphone, an amplifier 

microphone like for instance the "Hannover-Mikrofon" which is offered by 
the VTF or which can be built by yourself is suitable excellently. 

 
Recording directly into the computer 

It's also possible to record directly into the computer, so that the use of a 
cassette recorder is unnecessary. Required is a sound card which 
supports "full duplex", i.e. it must be capable of recording and playing 
back simultaneously. Most sound cards today meet this requirement. The 
microphone must be connected to the "Mic" input of the sound card 
instead of the cassette recorder. While the raw material is played back 
via the speakers, a sound recorder like for instance CoolEdit is turned to 
"recording" mode at the same time. Some sound cards require the same 
values for sample frequency, resolution and channels: If for example the 

source WAV file which is used for EVPmaker has the values "22050 Hz, 
16 bit, mono", then exactly these values must be used for the 
microphone recording in CoolEdit. Afterwards, the EVP recording can be 
listened to at the computer. Some sound editors offer the valuable 
feature to mark selected segments within the wave form by written 
notes. In CoolEdit, this can be done with the "Cue List" which can be 
accessed from the "View" menu. In this way, EVP interpretations can be 
entered directly, and the voices can be accessed later very quickly. 

 

Altering the segment durations 

But now back to EVPmaker: By changing the settings within the framed 
areas Segments and Play EVP, the random controlled playback of the 
segments can be varied further. First the segments: Here are two edit 

fields for the duration of the segments in milliseconds (ms), i.e. 1/1000 
seconds. By default, only the upper edit field labelled with From is 
active, while the other one, which is labelled with To, is greyed (= 
inactive). If the box on the left side of the lower edit field is checked, this 
field becomes active, too. The values in these fields control how much 
the signal is being chopped during the random controlled playback. If 
only the upper "From" value is active, all segments are equally long. If 

http://www.vtf.de/geraete_e.shtml
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also the lower "To" value is activated, then the segment length varies 
random controlled between these two values, which results in a more 
dynamic raw material. The segment duration can be increased or 
decreased by clicking on the little up/down arrows besides the input field. 
The valid range covers values from 1 ms to 10000 ms, which is 

equivalent to one thousandth to 10 seconds. Values around 100 
milliseconds (= 0.1 seconds) have turned out to be convenient. If the 
values are too big, parts of words or even whole words may become 
audible. If the values are too small, the signal is being distorted very 
much, which however can lead to interesting results. 

Right beside the input field for the segment duration there are the three 
checkboxes Overlap, Z-Cross ("Zero Cross") and X-Fade ("Cross 
Fade"), which will be explained now. 

 

Overlapped segment positions 

Overlap has the following meaning: Normally all segments are located 
seamlessly one after another on exactly defined positions. With a signal 
of 10 seconds and 100 ms segments there are for example exactly 100 

different possible positions where segments can be located (a). 
If Overlap is checked, any segment can start at any position within the 
audio signal, thus segments can overlap each other (b). This results in a 
higher variation of the generated raw material: 

  
Positions of the segments within the source WAV file a) without and b) with "Overlap" 

 
Avoiding Clicks 

If Z-Cross is checked, segments will be cut out from the audio signal 
only at positions where the wave form crosses the center line (zero 
amplitude). By this, audible pops or clicks during the random controlled 
playback of the segments are being eliminated. However, a side effect of 
this function is that the segment duration no more matches the preset 



value, but usually is a bit greater (for example 102 ms instead of 100 ms 
- it depends on how far the next zero crossing point is apart). In very 
unfavorable cases, it might even occur that the next zero crossing point 
will be found much later, or that it won't be found at all, so that single 
segments may last several seconds. This can for example occur when the 

signal has an DC Bias, i.e. when the zero amplitude of the signal has an 
offset towards the center line of the wave window, so that the wave form 
crosses the "actual" zero line only now and then. In such a case it might 
help to load the WAV file into a WAV editor and to "adjust" the signal 
(in CoolEdit, choose "Transform > Amplitude > Normalize", check the 
option "DC Bias Adjust", and normalize the signal to 90%). 

 

A softer sound 

With activated option X-Fade, consecutive segments will be gradually 
cross faded: 

 

While the volume of the new segment (Segment 2) gradually increases, 
the volume of the previous segment (Segment 1) decreases 
simultaneously. After reaching the maximum level, the current segment 

(Segment 2) slowly fades out while at the same time the next segment 
(Segment 3) slowly fades in, etc. This fading yields a "softer" sound since 
the cuts between the segments are no longer audible. However, with the 
same cutting frequency the length of each segment will double. 

 
Using a Cue List instead of arbitrary segments 

As mentioned, besides the option to use segments of fixed duration, the 
program can also be instructed to use the "cues" which have been stored 
in the WAV file to generate random speech. To achieve this, the 
option Use Cue list inside the area Segments must be selected. 
However, the just mentioned options Overlap and X-Fade take no effect 
if the cue list is used. But using cues instead of fixed-length segments 
will be explained in detail later. 

 
Automatic playback stop 



For EVP recordings, it is sometimes quite practical if after each asked 
question the raw material is being played back only for a certain time 
and then stops automatically, so that the next question can be asked. 
For this purpose,EVPmaker offers the option to preset a duration in 
seconds, after which the random controlled playback stops automatically. 

Normally, the playback runs until the  (Stop) button is clicked. This is 
the case if in the area Play EVP the option continuously is selected. To 
activate the automatic stop of the playback, for x s must be selected. In 
the corresponding input field of this option, a number of seconds can be 
entered, after which the playback of the raw material is being stopped. 
By clicking in the little up/down arrows, this value can be varied from 1 
to 99 seconds. 

This is all you have to know in order to generate raw material for EVP 
recordings. Any further description is only interesting if you intend to 

use EVPmaker's EVP Session feature in order to document and examine 
the obtained EVP scientifically. 

 
3.3. Recording a session 

The EVP Session feature is primarily meant to take down the generated 
raw material into a log file in order to be able to examine and to analyze 
it later. Thus it serves mainly scientific purposes and is less intended for 
all-day use, particularly since experience shows that most EVPs are 
audible only in the acoustic recording of the raw material and not already 
in the original raw material itself. By the unadulterated recording of the 
original raw material with the help of the function EVP Session one has, 

however, the possibility of comparing both with each other and that way 
documenting possible "transformations". 

In the session file (EVP file) not the result in form of a new WAV file is 
saved, but merely all parameters which have led to the generation of this 
raw material are recorded. This includes the name and the location 
(folder) of the used source WAV file as well as for each segment its 
position and length within the source WAV file. With the help of these 
details EVPmaker then is able to reproduce the raw material exactly. 
However, an "export" function allows also to store the acoustic final 

result as WAV file in addition (more on this later in this manual). 



In order to record a session, the recording mode must be activated by 
clicking the button Rec in the area EVP Session. While the recording 
mode is active, the label Recording appears in red letters on the right 
side of the upper border of the frame of this area: 

 

The recording mode can only be activated if either a WAV file has been 
opened, or a previously made recording has been saved as a WAV file. 

If a session file is already open, new EVP will be appended to the session. 

If during activated recording mode the random controlled playback is 
being started via the button  (Make EVP), at first a dialog box will be 
opened which allows you to enter an question: 

 



The question or the comment which may be entered here has only 
documentation purposes and doesn't have any effect on the generation 
of the raw material. However, with regard to the documentation of 
possible references of the EVP to a previously asked question it would be 
important to note the (mental or verbal) asked question. After closing 

the dialog box by clicking either OK or Cancel (OK will store the entered 
text into the session, Cancelwill discard it), the playback of the raw 
material begins. Simultaneously, the numbers of the randomly played 
back segments resp. of the cues are being logged. After playback has 
been stopped (either by clicking the upper (Stop) button, or 
automatically after a certain number of seconds), the next EVP can be 
recorded immediately by clicking on  (Make EVP) once more and 
entering a new question. At any time you can listen to any EVP which has 
been recorded so far, or to the entire session, by clicking on the 

lower Play resp. EVP button (explained below). To finish a session, the 
recording mode has to be terminated by clicking on Rec again. The red 
labelRecording will then disappear. The recording can be continued at 
any time later, but it is recommended to create a new session file for 
each EVP session. To start a new session while a previous session is still 
opened, click on the New button. If the previous session had not yet 
been saved, you will be asked to do so. The current session can be saved 
at any time by clicking on Save (explained below). 

 
3.4. Playing back a session 

Every single EVP that has been recorded in the session file is 

automatically being provided with the current date and time 
(Date/Time) and a consecutive number (EVP No.). The number before 
the slash is the number of the currently displayed EVP (sequence 
number), and the number after the slash is the total number of recorded 
EVP in this session. You can skip between the individual EVP by clicking 
on the buttons labelled - and +. Instead of clicking these buttons, you 
can alternatively use - and + on your keyboard. The previously entered 
question now appears in the field labelled Question: 



 

By clicking on the button Play, the entire session including all EVP will be 
played back completely, whereas the button EVP playes back only the 
currently displayed EVP. Stop terminates the playback prematurely. You 

can enter your interpretation of an EVP into the field EVP Answer. This 
also is important with regard to a documantation of references of the EVP 
to a previously asked question. 

 
3.5. Saving and loading a session 

After a session has been recorded, it should be saved into a session file. 
Any saved session can later be loaded into EVPmaker again in order to 
process it (for example to edit the interpretation text) or to listen to it. 
To save a session, click on the button Save. A dialog window will be 
opened to save the session file: 



 

The suggested filename is a combination of date and time of the first EVP 
which has been recorded in this session file. In the above example this is 
the session of 12 June 2000, 19:43:10 h. Of course the filename can be 
changed if it appears too "illegible" to you. The file extension is normally 
".evp". 

Saved sessions can be opened by a click on Open or by using the "Drag 
and Drop" method. At the same time also the corresponding source WAV 

file which has been used to generate the raw material will be loaded 
automatically. Thus the used WAV file should be preserved well; without 
it, the session cannot be opened later! 

If the source WAV file can't be found anymore when opening a session 
file because it has been renamed or moved to another folder, EVPmaker 
complains and asks if you would like to search for the matching file: 

 

If you answer Yes, an "Open" dialog will appear which lets you browse to 
and open the missing WAV file. 

After a session has been saved or an existing session has been opened, 
its filename will be displayed in the field labelled Session file. 



 
3.6. Saving an individual EVP as WAV file 

Perhaps you would like to save individual sequences of EVP raw material 
in order to archive them or to send them by e-mail. For this 
purpose, EVPmaker offers the export function which allows you to export 
the currently displayed EVP as a WAV file. After clicking on the 
button Exp, an dialog window is opened to save the file: 

 

The suggested filename is composed of the session file name, followed 
by a dash (-), followed by a three-digit number. This number is the 

consecutive number of the current EVP which is displayed behind EVP 
No. 

 
3.7. Loading an EVP into a Wave file editor 

In order to examine an EVP more exactly, it's recomended to open it in a 
suitable sound editor. My favorite one is CoolEdit which can be 
downloaded at http://www.syntrillium.com/ as a 30 day evaluation 
version. To load an EVP directly from EVPmaker into a sound editor, 
Windows must be configured so that WAV files will automatically be 
opened in this sound editor by a double-click. If this is not yet the case, 
this can be changed manually: In Windows Explorer, choose "Extras > 

Folder options > File types", and under "Registered file types" choose the 
type for WAV files, click on "Change", and in the window "Open with" 
choose your sound editor. (Note: Some terms may be different on your 
computer since I only have a German Windows version.) 

http://www.syntrillium.com/


If these preparations are done, you can load the currently displayed EVP 
into the editor by clicking EVPmaker's Edit button. This might look like 
this (here still the old version "CoolEdit 96"): 

 

The blue triangles above and below the wave window are the markers of 
the individual segments of which EVPmaker has composed the EVP 
sequence. These markers have been stored as "cues" in the WAV file and 
are now being displayed by CoolEdit. To show the cue list, choose "View 
> Cue List" from CoolEdit's menu. The list of the individual segments 
might for example look as follows: 

 

The individual segments are being displayed one below the other. By 
using the scrollbar on the right margin, you can scroll through all of the 
segments. Double-clicking a segment selects that segment in the 
waveform. In the first column of the cue list you see the exact positions 



of the segments within the loaded WAV file in seconds. The next column 
shows the labels of the segments. All segments are numbered 
consecutively, starting with 1. The label is also being displayed in the 
field "Label", if you click one of the cue list entries. Right beside the label 
there is a "Description" field which displays for each segment the name 

of the original WAV file (that one whichEVPmaker used to generate the 
EVP sequence), the number of samples, and the first and the last sample 
within the original WAV file. 

An EVP which was previously discovered in EVPmaker can now be 
examined much more precisely. For example you can zoom into the 
signal or switch to spectral view in order to analyze the frequency 
components of the signal: 

 

BTW: Not only those EVP which are loaded in the WAV editor are 
provided with a cue list, but also those EVP which have been exported as 
WAV files. 

 

3.8. Creating and using a phoneme set 

As mentioned above, EVPmaker can not only use arbitrarily choosed 
segments for the random controlled playback, but also individually 
selected parts which have been stored in the cue list of the source WAV 
file. By means of the cue list, a set of phonemes can be created which 



can be used to synthesize random speech. Phonemes are the smallest 
sound elements speech is being composed of; this comprises all 
consonants and vowels. To learn which phonemes are existing, look into 
a dictionary where the pronunciation of the language is explained. Now 
record a suitable text - either spoken by yourself, or an existing one -, 

select every single phoneme and add it to the cue list. For a label, you 
should use a short name. Since you can't use phonetic transcription 
symbols in the cue list, you have to manage with a kind of "pseudo 
phonetic transcription". In the Appendix I have listed the phonemes 
which I have used, along with their names and some pronunciation 
examples. [2] 

Next, zoom into the signal and select the phonemes by ear and by sight: 

 

Before you add a phoneme to the cue list, choose "Edit > Zero Crossings 
> Adjust Selection Inward" from the CoolEdit menu to align the selection 
to the nearest places where the waveform crosses the center line in 
order to eliminate clicks and pops. Then click on the "Add" button of the 
cue list window and enter a name for this phoneme into the field named 
"Label": 

http://www.stefanbion.de/evpmaker/evpmkr_e.htm#note2


 

Optionally you can enter a description. By the way, the labels can be 
used multiple, i.e. they needn't be unique, so phonemes can be stored in 
different variations (durations, pitches etc.) using the same name for it. 

To simulate a natural flow of speech, you could additionally include a few 
pauses. 

To save memory, you could open a second CoolEdit window and copy 
each phoneme you have selected in the first window into this second 
window so that all phonemes follow one after the other without gaps. 

When saving the phoneme set to disk, pay attention that the option 
"Save extra non-audio information" in the Save dialog is checked! If you 
forget this by mistake and overwrite an already existing phoneme file 
and then close Cool Edit, your complete cue list will from now on reside 

in Nirvana... ;-) 



 

The phoneme file can now be opened in EVPmaker. Below in the status 

line, after Cues, the number of the loaded phonemes are now being 
displayed. In order to use these phonemes instead of arbitrarily 
segments for the generation of the raw material, the option Use Cue 
list must be selected: 



 

The further procedure is the same as described in section 3.3. 
("Recording a session"). 

In addition to the heard interpretation of an EVP, you can now read the 

phonetic transcription which is displayed in the field Cue Labels. To 
change the font which is used to display the phonetic transcription, right-
click into this field and choose another font from the Font dialog. 
Individual sections or the complete line of phonetic transcription can be 
copied to the clipboard and pasted for instance to a text editor. Use the 
mouse to select a portion or the entire line and press the keys "Ctrl" and 
"C" simultaneously to copy the selected part to the clipboard. In your 
text processing program, press "Ctrl"+"V" to insert the text from the 
clipboard. 

In the example which is displayed above, for example the 
word "beschieden" (German for: "notified") was heard. In phonetic 
transcription this corresponds to the sequence "b t 3 3 sch: i i: m". At 
first sight this sequence has no big similarity to the word "beschieden", 
but as everybody knows the human hearing is pretty flexible... 



To examine this sequence further, the EVP is being loaded into a wave 
editor by clicking on Edit: 

 

Here the section which includes the heard phonetic 
sequence "beschieden" has been zoomed. In the spectral view you can 
clearly recognize the various phonemes: From 2.13 to 2.20 the plosive 
"b" with a preceding pause before suddenly the air deflates between the 
lips, then from 2.20 to 2.25 the inappropriate "t" - also a plosive with 
preceding pause -, followed by two "3" vowels (called "schwa" vowels), 
followed by a "sch" which can be recognized in the spectral view as 

hissing. Next the two "i" which result in a long "i:", then the "m" which 
sounds like am "n" with a preceeding plosive because of its suddenly (in 
fact unnaturally) beginning. 

In the cue list, the individual phonemes are listed in detail: 

 



The labels of the phonemes (= the "pseudo phonetic transcription") were 
added in brackets and between quotes after the segment labels. 

Well, this was only a little insight into the possibilities of 
how EVPmaker can help to objectify EVP interpretations. 

 

3.9. Effects 

By using effects, the source WAV file which is used for the generation of 

the raw material can be defamiliarized further. In the Extras menu you 
can find the following entries: 

 
Reverse Signal 

This function will turn over the entire audio signal so that it will play 
backwards. This could be used for EVP recordings to make a recording of 
speech in a language you understand more unintelligible, if you want to 
use very long segments, in which otherwise you would hear individual 
words. 

 
Add echo to signal 

With this function reverberation and echo effects can be produced. By 
this the audio signal will get more "volume". Two parameters will 
influence this effect: Delay in milliseconds and Decay in percent: 

 

Short delay times (less than 100 ms) will yield a reverberation effect, 
long delay times will yield echo. The duration of the reverberation or the 
number of echoes is determined by the decay: A small value will let the 
reverberation or the echo cease faster than a large value. 



 
Normalize signal 

This function will amplify the amplitude (i.e. the recording level) of the 
audio signal to the greatest possible amount that will not result in 
clipping. By this means, recordings which are too faint can be adjusted to 
an optimal level subsequently. 

* * * 

All three effects, Reverse Signal, Add echo to signal, and Normalize 
signal, will change the loaded WAV signal. Therefore if a new source 

WAV file is opened, or if EVPmaker is exited, you will be asked if you 
would like to save these changes: 

 

If the answer is Yes, the changes will be saved; if you want to keep the 
original WAV file, you should enter a new filename. You should do so if 

this WAV file has already been used for other EVP sessions! 

By clicking on  (Save), the WAV file can also be saved before. 

 
Speed control 

Opens a slider which lets you adjust the playback speed. It can be 

adjusted to values between 50% und 200%, which is bisection or 
doubling: 



 

Since this is yielded by changing the sampling rate of the WAV signal, it 
depends on the sound card it the variation of the speed is possible or 
not. If the resulting sampling rate lies beyond the capabilities of the used 

sound card, an corresponding error message will appear upon playback. 
It also depends on the capabilities of the sound card whether or not a 
change of the speed affects the playback immediately or only after an 
interruption and continuation of the playback. 

By the 100% button the playback speed can be reset to the original 
value by a single click. 

 
3.10. Visual Feedback 

This function is based on an idea someone suggested to me by e-mail. 
Here is an excerpt from it: 

Assuming that communication can be obtained through the random generation of information, what if, in addition to 

sound you also added visual images to enhance and clarify the verbal communications? This would not only make 

communication clearer (assuming we are communicating with other dimensional entities), it would make verification of 

this communication much more palpable if the images correlated or complemented the words. 

Let's say you had about five hundred or so images or symbols or colors. Here's a few ideas: a ufo, a cross, a dragon, a 

smiley face, a pentagram, a peace sign. These images of course would be randomly chosen in the same way the sound is 

on your program. Going by one theory, if these other dimensional intelligences actually can "see" the screen, there might 

be a way to program the software in which they have a real time interaction with it to see their "work in progress" so to 

speak. 



This idea sounds interesting. In order to be able to check 
it, EVPmaker has a so-called "Visual Feedback Window". It can be 
activated by choosing Visual feedback window from the Extras menu: 

 

If now the random-controlled playback is started by clicking on  (Make 
EVP), a certain symbol with a certain color for each segment will appear 
in this window during the generation of the raw material. 

As symbols, the 223 characters of the Windows font "Wingdings" are 
used by default: 



 

Combined with the 15 
colors  Black ,  Maroon ,  Green ,  Olive ,  Navy ,  Purple ,  Teal ,  Sil
ver ,  Gray ,  Red ,  Lime ,  Yellow ,  Blue ,  Fuchsia  and  Aqua  thes
e are 223 x 15 = 3345 possible different symbol/color combinations. This 
means of course that with more than 3345 segments a clear assignment 
of segments to such a symbol/color combination is no more possible. 
This is for instance the case if a WAV file of 8 minutes is subdivided into 

segments of 100 milliseconds: In this case there are 480 seconds / 0,1 
seconds = 4800 segments, thus more than existing symbol/color 
combinations. For this reason a corresponding note will be written at the 
bottom of the "Visual Feedback Window" if such a case occurs. Also it 
doesn't make sense to use variable segment durations or overlapping 
segments, since this can theoretically result in an "infinte" number of 
different segments. Therefore a corresponding note will appear here as 
well, if during random-controlled playback one of the 
options Overlap or Segments To is activated. 

By choosing Settings > Font in the menu of the "Visual Feedback 
Window", another font than the default "Wingdings" or a font size 
different from the default of 300 can be chosen: 



 

There are many Web pages where symbol fonts can be downloaded. Just 
pay attention that actually all 223 characters are used, since otherwise 
invisible "blanks" will be desplayed. "Webdings" for instance is another 

suitable font. 

A different font size is appropriate if the size of the feedback window is 
changed to fit to one's own screen resolution. The characters being 
displayed should fill the window as well as possible. 

 
3.11. Selecting the random number source 

As mentioned in the Introduction, the original idea behind the means of 
random controlled phoneme synthesis was a supposed paranormal 
influence on random number generators (RNG). Experiments have shown 
however, that meaningful EVP also occur by using program generated 
pseudo random numbers which can in no way be influenced. Similar 

observations have been made during psychokinesis (PK) experiments in 
parapsychology labs: PK influences of a display by test persons occured 
not only by use of "real" RNGs on the basis of radioactive decomposition, 
but also by use of computer generated pseudo random numbers. Even by 
use of so called "pre-recorded targets" (PRT), i.e. series of random 
numbers which have been recorded some time before the actual 
beginning of the experiment, this PK effect did occur, which by common 
sense should not be... 

http://www.microsoft.com/typography/web/fonts/webdings/default.htm


In order to be able to conduct experiments with these different 
possibilities for the random controlled phoneme synthesis in EVPmaker, 
you can choose between several ways of random number generation: 

 Pseudo random numbers: Uses program generated pseudo 
random numbers 

 Fractal equation: Uses the chaotic iteration result of the Logistic 
Growth Equation by Verhulst 

 Sound card: Allows to use "real" random numbers (e.g. by 
connecting a noise source to the input of the sound card) 

 File: Uses any binary file containing 16 bit integer numbers to 
simulates "pre-recorded targets" 

These three kinds of random sources can be selected in the Random 
source submenu which can be found in the Extras menu: 

 

In the following section, all of these options will be explained in detail: 

 
Pseudo RNG (Pseudo Random Numbers) 



This is the program-internal generation of pseudo random numbers, or 
more exaxtly, the "random()" function from the program library of 
the Borland C++ Builder 4.0 compiler which I have used. According to 
the documentation, this is a multiplicative, congruential random-number 
generator with a cycle length of 2³². 

 
Fractal formula 

With this setting, the random numbers are generated by means of a 
nonlinear equation which delivers nonpredictable results (deterministic 

chaos). At present only the the Growth Equation by Verhulst has been 
implemented: 

f(x) = r * x * (1 - x) 

This formula is for example used in biology to describe the growth of a 
population inside a closed system. This equation is non-linear and 
produces chaotic results when r is above 3.57. For more information 
about Verhulst Dynamics, see for instance here. 

Experiments by Prof. Dr. Johannes Hagel and Margot Tschapke [3] have 
shown, that the chaotic results of the iteration seem to support the EVP. 

Voices occur both within the noise which becomes audible when the x 
values are interpreted as sound samples, and when these values are 
used for the selection of phonemes or speech segments. 

If you select Fractal formula from the EVPmaker menu, the following 
mask will appear: 

http://www.glue.umd.edu/~akleidon/MODELS/VERHULST/VERHULST.html
http://www.mynetcologne.de/~nc-tschapma/
http://www.stefanbion.de/evpmaker/evpmkr_e.htm#note3


 

In the upper area (above the separation line) a Feigenbaum diagram is 
shown. Here you can experiment with various x and r values in order to 
explore the chaotic areas. By clicking on the Draw button the diagram 
will be drawn using the current values. A left-click into the diagram sets 
the graphics values: To enlarge an interesting area, first click to the 
upper left, then to the lower right edge of this area, and then click 
the Draw button. With Reset, the graphics values are set to default. 

In the lower part of the mask, the settings of the parameters r and x can 
be done, which are used for the generation of the random numbers. You 
can either enter these values directly into the two input fields on the left, 
or you can increase/decrease them by moving the sliders, or you choose 
a random value by clicking on the Random buttons, or you can 
simply right-click into the above displayed Feigenbaum diagram. With 
the Iterate! button, you can simulate some iterations to observe the 
behavior of the x parameter. If this mask had been opened during the 
random controlled playback (using Random source = Fractal formula), 

you can make these settings immediately audible by clicking 
the Apply button. The OK button does the same but additionally closes 
the mask. Cancel closes the mask without changing the r and x values 
for the program. 

 
Sound card 



To generate 32-bit random numbers, sample values are being read 
continually from the sound card. In most cases the background noise 
from the sound card itself will be sufficient, but if the sound card is "too 
good", i.e. if it isn't noisy or if it only whistles, then you will have to 
connect an external noise source to the Line input of the sound card, 

which for instance could be a radio that ist tuned to "white noise". 
Sometimes it also helps to simply shift up the microphone controls of the 
sound mixer. You'll have to try here for best results. If EVPmaker seems 
to "stutter" or if only a few segments are being repeated again and 
again, this usually means that the signal provided by the sound card isn't 
"randomly" enough. But perhaps this could have to do with the sample 
resolution. My Soundblaster AWE64 for instance won't record any noise if 
at the same time a 16-bit signal is being played back. Thus if the WAV 
file used by EVPmaker has a sample resolution of 16 bit, I'll have to feed 

an external signal into the sound card, whereas when using an 8-bit WAV 
file, the produced noise is sufficient. 

There will always be read 10240 sample values from the sound card at 
one go. If they are "used up", a new block of 10240 sample values will 
be read. This procedure repeats until the playback is stopped. When 
 (Make EVP) is invoked for the first time, at first such a block will be 
read, before the random controlled playback will start. During the 
playback, new blocks of sample values will be read if required. During the 
recording of new random samples from the sound card, a line will appear 

in the title of the EVPmaker window which displays the used sample 
parameters, e.g. Recording (44100 Hz, 16 bit) .... 

The setting Sound card does work only with "Full Duplex" sound cards, 
i.e. the sound card must be capable of recording one signal while playing 
back another signal simultaneously. Otherwise, an error message will 
appear. 

 

File 

Here the required integer values for the generation of random numbers 
are being read from a file instead of the sound card. In principle, any file 
can be used, but the values which are read from it will be interpreted as 
signed 16-bit integer numbers. Thus if soundfiles are used, they should 
have been recorded 

 


